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When I first started my marketing career and needed to include an image in one of my articles or post a picture on social media, the image’s format didn’t matter to me. In my eyes, JPG and PNG were exactly the same. Once I actually dug into the difference between the two, though, I realized they’re
quite different. But one format isn’t necessarily better than the other -- JPG is optimal for some situations while PNG is optimal for others. In a nutshell, JPG images are best suited for social media and blog posts because they’re optimized for photography and have a smaller file size than PNG images.
PNG images are best suited for web graphics and professional photography because they maintain their quality no matter how many times you open and save them, whereas JPG images decline in quality every time you open and save them. Fortunately, JPG and PNG images aren’t permanently stuck in
their respective file format. You can convert images from PNG to JPG and vice versa in less than one minute with the help of some free online tools. How to Batch Convert Files from PNG to JPG 1. Visit one of the free online PNG to JPG converters listed in the section below. 2. Upload your PNG images.
3. Press “Convert” to convert your PNG images to JPG images. 4. Click “Download” to download your new JPG images. Best PNG to JPG Converter Tools 1. iLoveImg With iLoveImg, you can convert up to 15 PNG files at a time without signing up for a free account. If you register for a free account, you
can convert up to 30 PNG files at a time. 2. png2jpg.com Png2jpg.com lets you convert up to 20 PNG files at a time. The free tool doesn’t ask for your email address. 3. online-convert.com Online-convert.com offers a free tool that lets you convert up to 20 PNG files at a time without giving them your
email address. If you buy their premium version, you can convert up to 200 PNG files at a time. How to Batch Convert Files from JPG to PNG 1. Visit one of the free online JPG to PNG converters listed in the section below. 2. Upload your JPG images. 3. Press “Convert” to convert your JPG images to
PNG images. 4. Click “Download” to download your new PNG images. Best JPG to PNG Converter Tools 1. ILoveImg With iLoveImg, you can convert up to 15 JPG files at a time without signing up for a free account. If you register for a free account, you can convert up to 30 JPG files at a time. 2.
jpg2png.com Jpg2png.com lets you convert up to 20 JPG files at a time. The free tool doesn’t ask for your email address. 3. online-convert.com Online-convert.com offers a free tool that lets you convert up to 20 JPG files at a time without giving them your email address. If you buy their premium version,
you can convert up to 200 JPG files at a time.   Originally published Nov 30, 2018 6:00:00 AM, updated December 30 2018 The best JPG to PDF converters allow you to convert images to PDF files simply and easily.JPG and PDF are both widely used file formats online, but sometimes you need to
convert between them. Hundreds of online JPG to PDF converters exist, and it’s even possible to convert from JPG to PDF using tools included on both Windows and Mac. That said, PDF conversion software can make the process easier.Most online PDF converters only let you convert one image at a
time. This can make converting hundreds or thousands of JPGs a laborious task. The best JPG to PDF converters have batch conversion, so you can combine multiple JPGs into a single PDF or create multiple PDFs from a folder of JPGs.Another useful feature is OCR (optical character recognition). A
converter with OCR can scan your JPGs for text that you can then edit in the converted PDF file.In this guide, we outline the best JPG to PDF converters currently available.We've featured the best free PDF editors and the best OCR software. The best PDF software is Adobe Acrobat Pro DC  Whatever
you need to convert to PDF format, Adobe Acrobat Pro DC is the tool for you. It gives you total freedom to create PDFs from scratch and edit existing documents without fuss, on desktop or mobile. Of course, it also has a comprehensive range of convertors, and is the best PDF software you can buy
overall. (Image credit: Soda PDF)Comprehensive JPG to PDF converterTODAY'S BEST DEALSSoda PDF has both online and desktop versions. Soda PDF Online is surprisingly full-featured and mirrors the desktop version almost exactly. This version is great for converting and editing PDFs from
anywhere, and the desktop version can be used offline without having to upload and download files, so you can get the best of both worlds.The Home version includes both the web and desktop apps and has a 30-day money-back guarantee. If you upgrade to the Premium version, you can create
password-protected PDFs and custom PDF forms and set PDF access permissions.Converting JPGs to PDF with Soda PDF is straightforward and includes the option to merge files into a single PDF or create individual PDFs for each JPG. When merging JPGs, you can easily rearrange the files into the
order you need. After the files are merged, you have a wealth of tools at your disposal for editing your new PDF.Soda PDF has support for a vast range of other file formats besides JPGs, so it can work as your go-to software for converting all kinds of files to and from the PDF format.(Image credit:
Wondershare)Excellent PDF editing toolsTODAY'S BEST DEALSPDFelement is a PDF editor and converter for Windows and Mac. Besides letting you convert between a host of file formats, the software has excellent tools you can use to edit your PDF files after conversion. There’s support for OCR,
form editing, digital signing, and online sharing through Dropbox and Google Drive.PDFelement offers a Standard plan which offers a lot of features, including editing, annotating, exporting, forms, and PDF file conversion. The Pro plan adds OCR, editable form fields, and batch processing of documents,
you’ll need the Pro version.(Image credit: SmallPDF)Accessible JPEG to PDF converterTODAY'S BEST DEALSSmallpdf is a set of PDF tools for converting, compressing, splitting, merging, and editing PDFs.Smallpdf has a free service but limits the number of files you can process. For unlimited
conversions, batch processing, and access to the desktop app, you’ll need the paid version. A 14-day trial is available, but you need to sign up using a credit card or PayPal to get it.Using Smallpdf to convert JPGs to PDFs is a breeze. You simply upload the JPGs, re-arrange their order as you see fit, and
select Create PDF Now. There are the basic options for setting page size and margins, as well as an editor where you can add text and shapes, but nothing like the advanced editing tools of Soda PDF or Wondershare PDFElement.(Image credit: Foxit)Powerful PDF conversionTODAY'S BEST
DEALSFoxit has been developing PDF tools since 2001, and the latest version of its PDF Editor (previously PhantomPDF) has many tools for converting and using JPGs in PDFs. The software’s step-by-step wizards take you through creating a single PDF from multiple JPGs or batch-creating multiple
PDF documents from JPGs.Foxit PDF Editor has a free 14-day evaluation. The Standard version can be paid for monthly, annually, or a one-time fee. The Business version offers support for PDF A/E/X, image editing, and redaction.There’s also a web version called Foxit PDF Editor Online that’s
currently free to use, but although you can convert single JPGs to PDFs and edit them afterward, it’s quite basic, lacking the advanced tools of the desktop version.(Image credit: Gonitro)Customizable PDF converterTODAY'S BEST DEALSFor JPG to PDF conversion, Nitro Pro is one of the best, as it
includes a lengthy list of custom options. For example, you can fine-tune the down-sampling and compression of images and set the page size and orientation of the generated PDFs.A Nitro Pro license is charged per user, and allows for the use of unlimited eSignatures. Special pricing for teams of over
20 users is available upon request. A 14-day trial can be used directly from the website.Overall, Nitro Pro is an excellent conversion tool, but the PDF editing tools lack the finesse of Soda PDF and Wondershare PDFElement.Also see: the best AutoCAD to PDF converter. By Yvette Bigornia A Portable
Document Format file, or PDF, is a file format created by Adobe Acrobat that converts any type of file to a noneditable format for viewing purposes from any computer. PDF files can be easily converted to various file formats, including image files such as Joint Photographic Experts Group format, or JPEG
format. JPEG images are compressed files for photographic images that can be used for websites, emails or archiving purposes. Adobe Creative Suite, which includes Acrobat, Photoshop and Illustrator, can easily convert PDFs to JPEGs. Open the PDF file from Acrobat. Go to the "File menu," select
"Open." Choose the file that you want to convert to a JPEG. Click "Open." Convert the file to JPEG. Go to the "File" menu and select "Export." Choose "Image" and select "JPEG." Rename the file. The "Save As" dialog box is open and the file extension automatically changes to ".jpg." Change the name of
the file if needed and save it in your file folder. Click "Save." Extract a page from the PDF document. Open the PDF file from the "File" menu. Select a page that you want to convert if the PDF file is a multipage document. Leave the "Page Options" alone. Click "Open." Save the extracted page to a JPEG
file. Go to the "File" menu and select "Save As." Select the JPEG format under the "Format" drop-down menu. Click "Save." Repeat Steps 1 and 2 to extract each page of the PDF document. Extract a page from the PDF document. Open the PDF file from the "File" menu. Select a page that you want to
convert if the PDF file is a multipage document. Click "Open." Export the PDF page as a JPEG file. Go to the "File" menu and select "Export." Select JPEG format under the "Save as Type" drop-down menu. Click "Save." Compress the JPEG image from the "JPEG Options" dialog box. Select the
compression quality from the drop-down menu---Low, Medium, High or Maximum---or move the slide ruler from "Smaller File" to "Larger File." Experiment with the Color Mode by choosing either "RGB," "CMYK" or "Grayscale." Select the resolution by choosing "Screen," "Medium," "High" or "Custom."
Select "OK." Open the JPEG file from Photoshop. Open "Photoshop" and select the file that you just converted to a JPEG. Edit the JPEG file if needed. As we keep building on old image technology, types of file formats keep piling up, each with their own nuances and uses. JPG, PNG, and GIF have
become the most common, but what sets them apart from each other? These formats have become the most popular because of their compatibility with modern browsers, broadband speeds, and the needs of average users. Join us as we take a detailed look at each format, and cover the strengths and
weaknesses of each. JPG (Joint Photographic Experts Group) JPG was a filetype developed by the Joint Photographic Experts Group (JPEG) to be a standard for professional photographers. Like the method ZIP files use to find redundancies in files to compress data, JPGs compress image data by
reducing sections of images to blocks of pixels or “tiles.” JPG compression has the unfortunate side effect of being permanent, however, as the technology for the file was created for storing large photographic image files in surprisingly small spaces, and not for photo editing. JPGs have become the de
facto standard image of the internet because they can be compressed so much. A typical JPG can be compressed at a ratio of anywhere from 2:1 to as high as 100:1, depending on your settings. Particularly back in the days of dial-up internet, JPGs were the only viable way to send image information.
However, because of the lossy nature of JPG, it is not an ideal way to store art files. Even the highest quality setting for JPG is compressed, and will change the look of your image, if only slightly. JPG is also not an ideal medium for typography, crisp lines, or even photographs with sharp edges, as they
are often blurred or smeared out by anti-aliasing. What is potentially worse, is that this loss can accumulate—saving multiple versions of artwork can cause degradation with every save. Even so, it is common to see these things saved as JPG, simply because the filetype is so ubiquitous. Close up of a
high quality JPG. Close up of a very lossy JPG. The Joint Photographic Experts Group developed lossless JPG technology to combat this serious problem of quality degradation. However, because of dial-up speeds and general lack of interest in high quality non-degrading files, the JPG-LS standard
never caught on. It is possible to download plugins that allow users to open and save the lossless JPG2000, and some programs, like Apple’s Preview application, can read and save JPG2000 directly out of the box. JPGs support 24-bit RGB and CMYK, as well as 8-bit Grayscale. I personally do not
recommend using CMYK color spaces in JPGs. It’s also important to note that Grayscale JPGs do not compress nearly as much as color ones do. GIF (Graphics Interchange Format) GIF, like JPG, is an older filetype, and one generally associated with the internet as opposed to photography. GIF stands
for “Graphics Interchange Format” and employs the same lossless LZW compression that TIFF images use. This technology was once controversial (for patent enforcement issues) but has become an accepted format since all patents have expired. Close up of an 8-bit color GIF. GIF is by nature an 8-bit
color file, meaning they are limited to a palette of 256 colors, which can be picked from the RGB color model and saved to a Color Look Up Table (CLUT), or simply “Color Table.” There are, however, standard color palettes, like the “Web Safe” palette. An important note is that Grayscale images are by
nature an 8-bit palette, so saving them as GIF is fairly ideal. Apart from support for transparency, GIF also is supports animations, limiting every frame to 256 preselected colors. While GIF is not lossy like JPG, conversion to 8-bit color distorts many images, using dither filters to optically blend, or “diffuse,”
colors, similar to halftone dots or pointilism. This can radically alter an image for the worse, or, in some cases, be used to create an interesting effect. Because of this non-lossy format, GIF can be used to keep tight lines on typography and geometric shapes, although these things are better suited to
vector graphic files like SVG or the Adobe Illustrator native format, AI. GIF is not ideal for modern photography, nor image storage. At small sizes with very limited color tables, GIF images can be smaller than JPG files. But at most ordinary sizes, JPG compression will create a smaller image. They are
largely out of date, useful only to create dancing babies or to sometimes create rough transparencies. PNG (Portable Network Graphics) PNG stands for Portable Network Graphics (or, depending on whom you ask, the recursive “PNG-Not-GIF”). It was developed as an open alternative to GIF, which
used the proprietary LZW compression algorithm discussed earlier. PNG is an excellent filetype for internet graphics, as it supports transparency in browsers with an elegance that GIF does not possess. Notice how the transparent color changes and blends with the background. Right-click the image to
see. This is actually one image that is on four different background colors. PNG supports 8-bit color like GIF, but also supports 24-bit color RGB, like JPG does. They are also non-lossy files, compressing photographic images without degrading image quality. PNG tends to be the biggest of the three
filetypes and isn’t supported by some (usually older) browsers. In addition to being an excellent format for transparency, the non-lossy nature of 24-bit PNG is ideal for screenshot software, allowing pixel for pixel reproduction of your desktop environment. Which to use? From left to right, these files are:
24-bit JPG Compressed, 8-bit GIF, 8-bit PNG, Full Quality 24-bit JPG, and 24-bit PNG. Note that the file sizes increase in this same direction. PNG is the largest image type for bigger images, often containing information you may or may not find useful, depending on your needs. 8-bit PNG is an option,
but GIF is smaller. Neither are optimal options for photography, as JPG is much smaller than lossless PNG with only minimal loss of quality. And for storage of high resolution files, JPG compresses to tiny proportions, with quality loss only visible on close inspection. In short: PNG is good option for
transparency and non-lossy, smaller files. Larger files, not so much, unless you demand non-lossy images. GIF is largely a novelty and only useful for animation, but can produce small 8-bit images. JPG is still the king for photographs and photo-like images on the internet, but be careful, as your file can
degrade with every save. Image of Keizersgracht, in Amsterdam by Massimo Catarinella via Wikipedia, released under Creative Commons license. Derivative images available under the same license. I don’t care to know who created the dancing baby.
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